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Email Features
Sending Email
tfmEditor was conceived as primarily a communication tool for printing or emailing short 
letters, memos, etc.    As such, it was never intended to be a fully-featured email client, 
however some effort has been made to include enough features that tfmEditor users 
can make effective use of email from within the application itself.    tfmEditor will send 
email,via an SMTP server.    tfmEditor email can include one attachment and can be 
addressed to the main recipient as well as one 'cc' recipient.    If the Save Copy to Self 
setting is selected on the Communications Settings page under Options/Settings then a 
copy of each email sent will be saved to the currently selected Copy to Self directory. 

Retrieving Email from your Server
In addition to sending email, tfmEditor can download email from your server (operated 
by your internet service provider).    When you choose File/Retrieve Email ,the Retrieve 
Email window opens.    Click on the lightening bolt or choose from the menu items to 
download email here.    The window will fill with a list of senders and subjects for each 
email message downloaded from the server.    Double clicking on a message listing will 
cause the message to be displayed in the editor window.    It is important to note that 
messages you wish to keep need to be saved explicitly before the Retrieve Email 
window is closed.    If a message has been deleted from your server during download 
and then is not saved before closing the message list of senders and subjects ( the 
Retrieve Email window ), it will be lost forever.    Messages can be saved by 
highlighting them in the list (the message that gets saved is the selected message in the 
messages list, not necessarily the one displayed in the editor window)and then clicking 
the arrow-pointing-into-the-folder icon or choosing Save Message from the menu.    
Attachments may be executed from within tfmEditor by choosing from the menu or tool 
bar of the Retrieve Email window, however, this version of tfmEditor does not support 
saving them to file (watch for this in version 2). 



Email and Directory Settings

By using the Options/Settings menu item of the main form, you can save certain 
important settings as defaults that will be available each time you open tfmEditor.    
Defaults for these settings will be written to the Windows registry and saved between 
sessions.    Also temporary changes can be made for the current session, or even 
temporarily between each operation that would use the setting.    For example you could 
change the saved email directory before saving each email message to save each one 
to a different directory.    tfmEditor is not really designed to support multiple POP3 
accounts, and the above method would be somewhat awkward, but it could be used in a 
pinch.    If a fully-featured email client is what you're after there are better choices than 
tfmEditor, which has been designed with different objectives.    The above explanation is 
to emphasize the difference between choosing settings with the Make These Settings 
Permanent radio button or the Use Them For This Session Only radio button clicked.    
In the former case the settings will be written to the registry and used by default each 
time tfmEditor is opened.    The latter setting will affect only the current session or 
current operation and will be gone when tfmEditor closes. 



File

New
Open
Save
Save As
Send Email
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Edit

Cut
Copy
Paste
Undo
Find
Replace



Text Attributes

Font
Bold
Italicize
Underline
Plain Text Only



Options

Default Editor Width
Default Width Only
Use Page Setup Width
Word Wrap
Stay on Top
Short Date Format
Start Clock
Start Timer
Settings



File/New
Begins a new document in the editor window; checks to save unsaved changes first if a 
document is already open.



File/Open
Opens a saved file; checks for saving unsaved work if a document is already open in 
the editor window.    It will initially point to the folder set as the save directory in 
Options/Settings



File/Save
Saves the file currently displayed in the editor window.    If the file already exists this 
command will save the document with any changes made since last save, or if it is new 
document this command will call the Save As command.    If this menu item is selected 
while there is an email message displayed in the editor window the message will be 
saved as a document, but not as an email message. 



File/Save As
Use this menu choice if you have made changes to a document and you wish to retain 
the original and save the changed document with a new name.    Also use this if you 
wish to save the same document again with a new name, or to a different folder.



File/Send Email

Clicking on File/Send Email pops up the above window at the top of the editor window. 
Fill in the appropriate information, and , assuming your SMTP server info has been 
entered in Options/Settings, the text in the editor window will be sent via email to 
'somebody@someisp.com'.    tfmEditor email operations of course require an 
operational Internet connection.    For more information about emailing with tfmEditor 
see 'Email Features'



File/Retrieve Email

Clicking on File/Retrieve Mail pops up the window below:

Using the Email Menu Commands you can download mail from your server, save 
messages, open saved messages and open copies-to-self which are save to the 
directory specified in Options/Settings if the 'Save Copy to Self of Sent Email' check box 
is checked.    Also attachments to a message can be executed by the associated 
application on your machine and messages can be deleted from your local folders if 
they are no longer wanted.    For more information about email using tfmEditor see 
'Email Features' 



Email Menu Commands

These are the menu choices available under Messages on the Retrieve Email window 
which is opened by choosing File/Retrieve Email from the editor window menu.    Many 
of these tasks can also be accomplished by choosing a button on the tool bar, or right 
clicking in the Retrieve Email window and choosing from the items on the pop-up menu.

Retrieve From Server
Save Selected Message
Retrieve Saved Mail
Retrieve Copies to Self
View Selected Message
Reply to Selected Message
Forward Selected Message
Delete Selected Message
View with Full Header
Execute Attachment



File/Page Setup
Clicking on 'Page Setup' will pop up the page setup dialog where margins can be set.    
When the 'Use Page Setup Width' choice is checked under 'Options', the editor will 
show approximately the printed page width (if your paper width is 81/2'').tfmEditor was 
designed and runs best at a screen resolution of 1024x768; the 'Use Page Setup Width' 
may not give satisfactory results at lower screen resolutions.    For 81/2' paper the Page 
Setup Width gives an approximation of how the page width will appear when printed; 
this is not the case for page length.    If you set your top and bottom margin to 3 inches 
each, the printed page will have these margins even though this can't be seen in the 
editor window.



File/Print
Prints the contents of the editor window to the selected printer. 



File/Exit
Choosing this command closed all windows and exits tfmEditor.    The application will 
check to save unsaved changes to the document in the editor window. 



Edit/Cut
Choosing 'Cut' from the Edit menu will cut any selected text in the editor window and 
place it on the Windows clipboard.    This can also be accomplished by right clicking in 
the editor window and then choosing 'Cut' from the pop up menu.



Edit/Copy
Choosing 'Copy' from the Edit menu will copy any selected text in the editor window to 
the Windows clipboard.    This can also be accomplished by right clicking in the editor 
window and then choosing 'Copy' from the pop up menu.



Edit/Paste
Choosing 'Paste' from the Edit menu will paste any    text on the Windows clipboard at 
the cursor position in the editor window.    This can also be accomplished by right 
clicking in the editor window and then choosing 'Paste' from the pop up menu.



Edit/Undo
This will reverse the effect of the last editing or text attribute change made to the 
document displayed in the editor window.    Undo can also be accessed by right clicking 
on the editor window and choosing 'Undo' from the pop up menu.



Edit/Find
This menu choice calls up a standard text find dialog box. Text can be searched case 
sensitive or not, and whole-word or not. 



Edit/Replace
This menu choice presents a standard dialog that allows searching for and replacing 
text.    If the Replace All option is chosen each instance of the search text will be found 
and confirmation asked before replacement takes place. 



Text Attributes/Font
Brings up the standard Windows font dialog box, which allows changes to font face, 
size, color ,and bold, underlined or italicized attributes.    The changes only affect 
selected text in the editor window, or text added after the cursor if no text is selected.    
Any one attribute can be changed without affecting other attributes if the selected text 
includes text with various attributes, for example if your selection contains one line of 10 
pt. red text and another line with 12 point blue text you can use the font dialog box to 
bold the entire selection without affecting other attributes



Text Attributes/Bold
This toggles Bold on or off for the text currently selected in the editor window.



Text Attributes/Italicize
This toggles italics on or off for the currently selected text in the editor window. 



Text Attributes/Underline
This toggles underlining on or off for the currently selected text in the editor window. 



Text Attributes/Plain Text Only
This menu choice toggles on or off plain text only.    When tfmEditor starts it is set by 
default to plain text.    Toggling Plain-Text-Only off allows the use of font attributes, and 
documents are saved as rich text format files.    The user can choose to use plain text if 
rich text features are not wanted.    If you choose Plain Text Only    the default filter in the 
open dialog will be '.txt' and files will be saved in the plain text format.    Though the 
default filter is '.txt' this can be changed, and any text file can be opened.    If you are 
working on a document for which formatting changes have been made you will be 
warned that all formatting will be lost.    If you choose to continue all the text in the 
document will be converted to plain text.    Changing back to rich text will not restore the 
formatting. 



Author, Contacting tfmSoftware

Hi,
I'm JD Wells, the person responsible for tfmSoftware and tfmEditor.    If you have any 
questions, suggestions or whatnot I'd love to hear from you at 

tfm@pacifier.com
or jdwells@seasurf.com

I am on the verge of releasing (12/27/97) what I consider the final beta version ( beta 5) 
of tfmEditor version 1.    I will continue to develop tfmEditor (a spell checker, more word 
processor like features, better email integration, among other things, are on the 
horizon), as well as begin work on on other projects I have on the back burner.    Drop in 
at:

http://www.pacifier.com/~tfm 
to stay abreast of the progress, or better yet, email register your version of tfmEditor 
(tfm@pacifier.com) and receive email announcements of updates. 

Thanks for trying tfmEditor...
JD Wells
tfmSoftware



Registration, Legal
This is a free beta version of tfmEditor, subject to the following conditions

tfmEditor Version 1 Beta 5
Copyright (C) 1997 JD Wells/tfmSoftware
All Rights Reserved

License Agreement

You should carefully read the following terms and conditions
before using this software.    Unless you have a different license
agreement signed by JD Wells, your use of this software indicates 
your acceptance of this license agreement and warranty.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE PROVIDED "AS IS" AND
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY
OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.    Because of the
various hardware and software environments into which tfmEditor may
be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS
OFFERED.

Good data processing procedure dictates that any program be
thoroughly tested with non-critical data before relying on it.
The user must assume the entire risk of using the program. 

Evaluation and Registration

This Beta version of tfmEditor is free.    Subject to the terms below, 
you are hereby licensed to use this software. You may not alter or modify 
the Software and cannot give anyone else permission to modify the software.

Distribution

You are hereby licensed to make as many copies of Version 1 Beta 5
of this software and documentation as you wish; give exact copies of
the original tfmEditor V1B5 to anyone; and distribute tfmEditor V1B5 
and documentation in its unmodified form via electronic means. 

You are specifically prohibited from charging, or requesting
donations, for any such copies, however made; and from
distributing the software and/or documentation with other products
(commercial or otherwise) without prior written permission.

###



Options/Default Editor Width
Choosing this option simply adjusts the width of the Editor window to the size it is when 
tfmEditor first opens.



Options/Default Width Only
This toggles on or off Default Width Only.    When default width is set you will be unable 
to resize the width of tfmEditor.    The default width is the width at which tfmEditor opens. 
This setting only persists during the current session.



Options/Use Page Setup Width
This menu choice sets the width of the editor window so that, after calling Page Setup 
from the file window, the width of the current document appears roughly as it will print.    
tfmEditor does not support hard page breaks so there is no reason to attempt showing 
page length.    tfmEditor prints within the margins chosen from Page Setup, and when 
the page length is reached it begins printing a new page.    tfmEditor was designed with 
a screen resolution of 1024 x 768 in mind.    At other resolutions this setting will be less 
useful.



Options/Word Wrap
This menu choice toggles on or off Word Wrap which is on by default when tfmEditor 
opens.    If Word Wrap is on the text will be wrapped to the margins set by the call to 
Page Setup on the File menu or to the default margins tfmEditor uses when it opens.    If 
you print a document with Word Wrap off, the text will still wrap to the default page 
margins used by tfmEditor. 



Options/Stay on Top
This menu choice toggles Stay on Top.    If Stay on Top is set tfmEditor will stay visible 
even when another application is made active.    Stay on Top is automatically toggled off 
temporarily when the Retrieve Mail window is open because it stays on top of the editor 
window, if both windows were set to Stay on Top the behavior of both would be 
unpredictable.



Options/Short Date Format
This toggles on and off the short date format.    When you click it you will see the results 
in the date edit field.    What shows in the    date field is what will be inserted into the 
document when the date edit is double clicked.



Options/Start Clock
Allowing the clock to run uses Windows resources.    The time field on the tool bar in 
tfmEditor is not running by default.    It sets itself to the current time when tfmEditor 
opens and then synchronizes to your computer's system time when the clock icon on 
the tool bar is clicked.    If you wish to monitor the time continuously, you can toggle the 
clock on with this menu command.    The clock will keep time fairly well but if more 
accuracy is desired you may wish to click the clock icon on the tool bar occasionally to 
resynchronize the tfmEditor clock to your system clock.    Double clicking the time field 
on the tool bar will insert the time into your document.



Options/Start Timer
As opposed to running the clock, running the timer uses virtually no Windows 
resources.    Choosing this menu option simply records the current time.    Then when 
this menu choice is clicked again the time is recorded and the elapsed time between the 
two events is returned via a message box.    For example you could open tfmEditor, 
choose Start the Timer, begin composing email or what ever, then when you're finished 
with your task, choose Options/Stop the Timer (the text changes when you choose Start 
the Timer) to find how long your tasks have taken.    It looks like this:



Options/Settings
Configuration settings made from the menu commands are for the session only; they 
will not still be active the next time you open tfmEditor.    The settings made in 
Options/Settings, however can be saved between sessions.    The settings dialog has 
two pages as below:

The first page is for setting directories that tfmEditor will use by default when opening 
and saving documents or saving and opening email messages.    The Copy to Self 
Directory is where a copy of email messages you send will be saved if this option is 
checked on the Communications Settings page.    These settings can be made the 
permanent default, or used for the current session only depending which radio button is 
selected when the 'OK' button is clicked.    Double clicking on each field will call a folder 
browser dialog to facilitate choosing a directory.

Communication settings:

These are the settings that allow email communication via an internet email account.    If 
you don't know what to enter in these fields contact your internet service provider.    
They can give you this info.    If you have more than one email account you can change 
these settings each time you want to download mail from a different account, though 
tfmEditor is not really designed to support multiple accounts.    If Save Copy to Self of 



Sent Email is checked then each time you use tfmEditor to send email, a copy of the 
message will be saved in whatever is currently set as your Copy to Self directory (on the 
Directory Settings page).    If Delete Mail From the Server After Downloading is checked, 
then messages downloaded will no longer be available from the server.    It would be 
good to know that messages downloaded by tfmEditor need to be explicitly saved by 
choosing the appropriate menu item in the Retrieve Mail window.    If mail is 
downloaded, deleted from the server and then tfmEditor is closed without having 
explicitly saved messages, they will be lost forever.    As with the Directory Settings 
page, these settings can be made permanent defaults or set for the current session only



Retrieve From Server
This menu choice will retrieve mail via a current connection to the Internet from the 
server set in Options/Settings on the Communications Settings page.



Save Selected Message

This menu choice will save the currently selected email message.    Note that this is the 
message currently highlighted in the list of messages, and is not necessarily the 
message currently displayed in the editor window.    It is also important to be aware that 
messages downloaded by tfmEditor must be explicitly saved by choosing from the 
menu or tool bar; messages not saved will be lost for good when the Retrieve Email 
window is closed.    This is an especially crucial consideration if the messages have 
been deleted from the server. 
The message will be saved by default to the directory set in the Directory Settings page 
of Options/Settings.    If you wish to save email to different directories you can change 
the email directory to a different directory before saving messages.    The chosen 
directory must already exist. 

Note:
Any time a message is displayed in the editor window it can be saved from the File 
menu of the editor window.    This will save the contents of the editor window as a text or 
rich text file, but not as an email message.    Choosing the Save Selected Message from 
the Retrieve Email window menu will cause the message to be saved as an actual email 
message. 



Retrieve Saved Mail

Choosing this menu command will fill the Retrieve Email window list with messages 
saved to the currently set email directory on the Directory Settings page of 
Options/Settings.    If you have saved email to different directories you can choose the 
directory where you would like to retrieve messages from by going to Options/Settings 
before retrieving saved email.    The retrieved messages may then be replied to, 
forwarded or have any attachments executed, or be viewed in the editor window. 



Retrieve Copies to Self
Choose this menu item to view copies of messages you have sent.    tfmEditor does not 
automatically save copies of sent email; this option must be set on the Communications 
Settings page of Options/Settings on the menu of the editor window. 



View Selected Message
This menu choice will cause the message currently selected in the message list to be 
displayed in the editor window.    Any time a message is displayed in the editor window it 
can be saved from the File menu of the editor window.    This will save the contents of 
the editor window as a text or rich text file, but not as an email message.    Choosing the 
Save Selected Message from the Retrieve Email window menu will cause the message 
to be saved as an actual email message. 



Reply to Selected Message
This option makes it easy to reply to a selected email message.    The message replied 
to will be the one selected in the Retrieve Email window message list and not 
necessarily the one currently displayed in the editor window. 



Forward Selected Message
This option makes it easy to forward a selected email message.    The message 
forwarded will be the one selected in the Retrieve Email window message list and not 
necessarily the one currently displayed in the editor window. 



Delete Selected Message
This will delete the locally saved copy of the currently selected email message The 
message deleted will be the one selected in the Retrieve Email window message list 
and not necessarily the one currently displayed in the editor window. 
Note: This is not the same as deleting an email message from your server.



View with Full Header
This menu choice allows you to view an email message with a lot of header information 
that you may or may not wish to see.    But it's there if you should happen to wish to see 
it. 



Execute Attachment
This will execute an email attachment using the currently associated application.    For 
example a bitmap file will probably be opened by Paint and a text file will probably 
cause Notepad to open and view the file.    In this version of tfmEditor, saving 
attachments to a file directly is not supported.    (Watch for it in version 2)



Some Random Stuff

ComCtl32.dll

This is a function library that is part of the Windows 95 operating system.    Unfortunately 
there are different versions of Windows 95 and comctl32.dll.    tfmEditor needs the 
version 4.70 of comctl32.dll.    If you have recently installed a copy of Internet Explorer 
on your computer (3.0 or later, I believe) then you probably have version 4.70 or later.    
If you wonder which version you have you can find the file (In Explorer choose 
Tools/Find/Files or Folders, search your hard drive, or just the Windows directory for 
comctl32.dll) on your computer and right click on it.    Choose 'Properties' from the pop-
up menu then choose the 'Version' tab of the dialog.    The version number will be there. 
If you want an updated version of comctl32.dll and don't want to install Internet Explorer 
on your computer, you can download a self extracting update file from the Microsoft web 
site.
Here is the info page:
http://support.microsoft.com/support/kb/articles/Q165/4/87.asp
Here's the actual download address:
http://support.microsoft.com/download/support/mslfiles/Com32upd.exe

The Microsoft site changes over time so I don't know how long these addresses will be 
valid.    If you have a problem with comctl32.dll, email me:    (jdwells@seasurf.com), and 
I'll see what I can do. 

Screen Resolution:

I unabashedly favor the 1024 x 768 screen resolution, and tfmEditor will look and 
behave better at this resolution.    It may perform acceptably at other resolutions, but it 
was designed in and for 1024 x 768.



If you can't enter text in the editor window

If nothing happens when you try to enter text in the editor window, click on the menu 
item Options/Max Size - 1 Meg. This should fix the problem.    By default the maximum 
document length for tfmEditor's editor window is 100 MB.    For reasons I'm not sure of, 
this setting won't work on some machines.    Setting the maximum document length to 1 
MB should solve the problem. 






